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In this class we are going to look at how we can create and model geological data with the Geotechnical 
Module in AutoCAD Civil 3D software. The class will cover how to import and generate boring holes and 
surfaces in AutoCAD Civil 3D software, and then we’ll go on to cover the essential techniques in 
modeling the subsurface data. The class will see how to use Feature Lines and Break Lines to mold and 
manipulate AutoCAD Civil 3D software surfaces to model geotechnical features. We will then learn how 
to convert the AutoCAD Civil 3D surfaces into AutoCAD software 3D solids ready for use in other 
software systems like Revit software and InfraWorks software. This class is designed to assist you in 
your understanding of the techniques used to model and visualize substrata in order to better 
understand and present information 

Learning Objectives 
At the end of this class, you will be able to: 

 Learn how to import and create boring holes and surfaces 

 Understand the principles of modeling geology surfaces 

 Comprehend the use and role of Feature Lines and Break Lines in modeling geology 

 Learn how to convert the subsurface data in AutoCAD software 3D solids ready for export 

 

About the Speaker 

Gary Morin, originally trained as a civil engineer and has over 30 years experience working in 

the production and support of a range of geographic information systems and CAD software 

systems. As the technical director of Keynetix, which he co-founded in 2000 to specialize in 

geotechnical data management software, Gary heads up the geotechnical Building Information 

Modeling (BIM) development and is responsible for the design and support services for a range 

of products designed to manage geotechnical data in the BIM process, including the 

HoleBASE SI extension, the Geotechnical Module from Autodesk, and advance HoleBASE SI 

extension for AutoCAD Civil 3D software. 

 

Gary.morin@keynetix.com 

Linkedin:  uk.linkedin.com/in/garymorin63 
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Learn How to Import and Create Boring Holes and Surfaces 
In this session we are going to look at the CSV format for importing boring locations and 

geology strata. 

To enable this it is essential that the two files required are in the correct format and have the 

correct data.  

File format 

The file should be true CSV (Comma separated Values), the Geotechnical Module does allow 

different delimiters, but this needs to be specified within the Import dialog. 

Delimiters supported: 

 Comma (,) 

 Semicolon (;) 

 Colon (:) 

 Vertical Bar (|) 

 Tab 

In the UK and USA we use a dot (.) to represent the decimal point, if in your language you use a 

different character, ensure you have the correct operating system language specified for the 

corresponding point character, otherwise errors will occur. 

Text does not need to be quoted. 

The two files can be of any name, but should have the .CSV extension. 

The two files contain: 

 Boring Locations 

 Boring Strata 

 

  

Rules 

Always open drawings from within AutoCAD Civil 3D, DO NOT open drawings from File 

Explorer, as the Geotechnical Module will not start up correctly. 
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Boring Locations 

This file contains the information relating to the location of each of the boring. 

The file should include a row for each boring location, containing the following information. The 

file must use the precise column headings specified. 

Column 

Heading 

Description Mandatory Example 

LocationID Location unique ID Yes BH0001 

LocationType Type of activity at location Yes RC 

Easting Easting or longitude of the location of hole Yes 123456.4 

Northing Northing or latitude of the location Yes 232467.3 

GroundLevel Ground level relative to datum of location 
or start of traverse 

Yes 35.43 

FinalDepth Final Depth  8.37 

Orientation Orientation of hole (degrees Clockwise 
from north) 

 87 

Inclination Inclination of hole (measured positively 
down from horizontal in deg) 

 56.3 

 

Example location file: 

LocationID,LocationType,Easting,Northing,Ground Level,FinalDepth,Orientation,Inclination 
BH13,RC,348810.69,312280.95,57.33,,, 
BH9,RC,348801.13,312224.73,51.98,,, 
BH8,RC,348776.3,312250.22,53.06,,, 
BH11,RC,348749.43,312520.97,62.99,,, 
BH1,RC,348743.68,312482.79,61.64,,, 
BH19,RC,348740.94,312224.17,50.68,,, 
BH3,RC,348731.53,312327.8,57.33,,, 

 

Boring Strata 

The Boring Strata file contains all of the strata readings from down individual borings. 
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Column Heading Description Mandatory Example 

LocationID Location identifier Yes BH001 

DepthTop Depth to the TOP of stratum Yes 7.43 

DepthBase Depth to the BASE of description Yes 8.12 

GeologyCode Geology code At least one 

of these 

fields must 

exist 

LC 

GeologyCode2 Second geology code SAND 

LegCode Legend code 102 

 

The strata banded in the geotechnical module is made on one of the three columns 

GeologyCode, GeologyCode2 or LegCode. The strata names contained within the three 

columns should be consistent throughout the project, but the actual values are entirely up to 

you, although if you have render materials based on strata name they should match your 

materials. 

However it is best to use GeologyCode column as the default strata as this is used to 

segment/band the 3D boreholes. 

Example 

LocationID,DepthTop,DepthBase,LegCode,GeologyCode,GeologyCode2 
BH1,0,0.5,101,TOPSOIL, 
BH1,0.5,1.5,102,MADE, 
BH1,1.5,3,803,SANDSTONE, 
BH1,3,4.5,801,SANDSTONE, 
BH1,4.5,8,803,SANDSTONE, 
BH1,8,12,803,SANDSTONE, 
BH10,0,0.6,101,TOPSOIL, 
BH10,0.6,1.4,102,MADE, 
BH10,1.4,3.1,201,CLAY, 
BH10,3.1,5.8,501,GRAVEL, 
BH10,5.8,8.6,803,SANDSTONE, 

 

Data entry rules for strata 

1. Each record must contain a valid location ID 

2. Depth top and depth base must be specified for each record. 

3. The strata bands should not overlap down an individual hole 
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4. Use consistent stratum names. 

Exercise 1: Creating and validating the CSV files 

In this exercise we are going to create the two CSV files from existing Microsoft Excel 

workbooks and validate them using notepad. 

1. Navigate to folder: 

C:\datasets\Hands–On–Labs\CV5674-L Modeling and Visualizing Geology Subsurfaces with 

AutoCAD Civil 3D Ready for BIM 

2. Double click on the boring locations.xlsx file 

The file will open in Microsoft Excel 

 

3. From the File tab select Save As 

4. From the Save as type list pick CSV (MS-DOS) (*.csv) 



Modeling and Visualizing Geology Subsurfaces with AutoCAD Civil 3D Ready for BIM 

6 
 

 

5. Press Save to save the CSV file 

6. From within the folder Right click on the boring location.csv file and select Notepad from 

the Open with command. 

7. From within notepad check that the file 

format is correct and that it has the 

correct comma (,) delimiters 
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8. Once the file has been validated close Notepad. 

9. Repeat steps  2 – 8 for Boring Strata.xlsx 

You should now have two files in the correct format ready for import into the Geotechnical 

Module. 

Exercise 2: Importing CSV files into the Geotechnical Module 

In this exercise we are going to take the two CSV files just created and import them into the 

Geotechnical Module to create the 3D boreholes in AutoCAD Civil 3D. 

1. Run AutoCAD Civil 3D 2015 

2. Open exercise 2.dwg in the folder: 

C:\Datasets\Hands–On–Labs\CV5674-L Modeling and Visualizing Geology Subsurfaces 

with AutoCAD Civil 3D Ready for BIM  
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3. From the Geotechnical tab click Import. 

 

 

 

4. The Geotechnical Module Import dialog 

will be displayed. 

 

5. From the File Type drop-down pick CSV 

 

 

6. For the Hole/Location File Path  

Click the Browse button and select the 

Boring location.csv file, in folder  C:\Datasets\Hands–On–Labs\CV5674-L Modeling and 

Visualizing Geology Subsurfaces with AutoCAD Civil 3D Ready for BIM 

Press Open 

7. For the Geology/Strata File Path  

Click the Browse button and select the Boring strata csv file, in folder  C:\Datasets\Hands–

On–Labs\CV5674-L Modeling and Visualizing Geology Subsurfaces with AutoCAD Civil 3D 

Ready for BIM 

Press Open 

8. From the Delimiter drop-down ensure Comma (,) is selected 
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9. Press Import to start the process. 

 

The Import dialog will be updated to display the number of locations and strata details being 

imported. 

10. Press Import to continue. 

The import process will be completed with the display of the boring locations in plan. 

 

11. Press Shift and Wheel button to perform a constrained orbit of the 3D model. 
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12. Click 2D Wireframe and change the visual style to Shaded 

 

A shaded view is created showing the 3D boreholes in contexts with the survey ground 

model. 
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Understand the Principles of Modelling Geology Surfaces 
In this section we will look at some of the basic fundamentals in modeling geology with the 

Geotechnical Module. 

It is essential you understand your data and especially the order of the strata. 

 Take time to review the geology in the data. 

o Look for where geologies appear and don’t appear 

o Look for the extents of a particular geology 

o Look for anomalies in the data 

 Use the 3D Boreholes to look at where the different geology appears around the site. 

 Use the Plan log strips as an aid to the extents of geology when working in plan. 

 Use profiles to highlight problems and discrepancies in the model. 

Exercise 3: Using 3D Boreholes and Plan Log Strips 

In this exercise we are going to review the extents of the imported geological data and then 

create log strips on plan for reference. 

1. Open exercise 3.dwg in the folder: 

C:\Datasets\Hands–On–Labs\CV5674-L Modeling and Visualizing Geology Subsurfaces 

with AutoCAD Civil 3D Ready for BIM  
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2. Now hide the Ground from Survey surface. From the 

Tool Space Prospector right click on the Ground from 

Survey surface and pick Surface Properties… 

 

 

 

 

 

3. In the Surface Properties 

dialog box, select _No 

Display from the Surface 

Style list box and press okay. 

 

 

 

 

 

 

 

4. Explore the 3D data, use shift 

and middle button to do a 

constrained orbit to better 

understand the position and 

layout of the boring information. 

 

Note: the area circled, there is no 

cyan indicating the lack of gravel 

in this area. 
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In the area to the top left there are some green segments indicating the extents of clay, but 

they do not appear in any other part of the site. 

 

5. Revert back to Top View and change the Visual Style back to 2D wireframe. 

       

6. From the Geotechnical tab pick Borehole Manager to display the dialog. 
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7. The Borehole Manager displays all boring locations in the import and gives control on what 

elements are displayed. 

 

8. Toggle on the Strip Check box 

for borings BH1, BH10, BH14 

and BH18. 

Log strips are created and 

displayed against each of the 

corresponding boring locations. 

These can be a great aid in 

understanding location of 

geology and the order of the 

strata. Notice the logs on the 

left show gravel but the ones 

on the right do not. 

Note: if the following message is displayed: 

 

Click Okay, then click Check for Updates in the Geotechnical tab, click Okay and 

then try the Borehole Manager again. 
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Exercise 4: Using Geotechnical Profiles to Check Data 

In this exercise we will look at another technique for understanding geotechnical data in 

AutoCAD Civil 3D. The Geotechnical Module allows the quick creation of geotechnical profiles 

which include both log strips and hatched stratum bands. These are ideal for giving a quick 

visual indication of the location of geology, they also work as an aid in displaying updates to the 

geological model as it is altered. 

However it should be pointed out when creating geotechnical profiles on the initial un-

interpreted data many inaccuracies are likely. It is through the modeling process, using feature 

lines and break lines we can attempt to do a more accurate model of the data and improve the 

look of the geotechnical profile. 

1. Open exercise 4.dwg in the folder: 

C:\Datasets\Hands–On–Labs\CV5674-L Modeling and Visualizing Geology Subsurfaces 

with AutoCAD Civil 3D Ready for BIM  

2. From the Geotechnical tab click Strata Manager 

 

3. The Strata Manager dialog is 

displayed, this lists a row for each 

Stratum in the imported data.  

 

Toggling on the Display Top and 

Display Bottom checkboxes will 

create and display AutoCAD Civil 3D 

surfaces for the top and base of the stratum. When toggled off the surface will be hidden but 

Note: If the following message is displayed: 

 

Click Okay, then click Check for Updates in the Geotechnical tab, click Okay and 

then try the Strata Manager again. 
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not deleted, toggling on the surface will just redisplay it. This way edits and modifications to 

the surface are maintained. 

Note: the surfaces created are not interpreted surfaces, they are just triangulation, joining 

the dots between identical geology codes in each boring. 

4. Toggle on all geology surfaces 

in the Strata Manager. 

 

 

 

 

 

 

 

5. You may find you will need to set the surface styles of the newly created surfaces, if so 

follow these steps: 

1. In the Tool Space Prospector click Surfaces. 

2. In the list of surfaces, select all stratum surfaces, by 

Pressing Ctrl and left clicking all the required surfaces. 

3. Right click on the Style column heading and click Edit…  

 

From the style list select Contours and Triangles 5x and press 

Okay. 
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6. From the View Tab click Viewport Configuration and select 

Three: Left viewport screen. 

 

 

 

 

7. Then arrange the views as below: 

 

8. From the Strata Manager, toggle off the display of the Topsoil top and bottom surfaces 

and also repeat for Made. This will give a better view of the underlying strata. 

     

9. From the Geotechnical tab click Create, the create Geotechnical Profile dialog will be 

displayed. 
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10. Enter Section AA for the Profile Name. 

11. From the Profile Style list Select Major Grids. 

 

12. Click Create New to create a new alignment for the geotechnical profile. 

Click two points as indicated below and 

enter AA as the alignment name at the 

command prompt. 
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13. Now click Next, to display the next screen of the Create Geotechnical Profile command. 

 

14. Enter 20 for the Buffer Surrounding Alignment, any boring within 20 AutoCAD units of the 

alignment line will be selected when Add Boreholes is pressed 

15. Ensure Dynamic Buffer is checked on, if the alignment is moved any borings within the 

specified buffer will be projected onto the profile. 

16. Click Add Boreholes, to list the matching boring locations in the Selected Boreholes grid 

below. 

17. Press Create, in the top right viewport 

click a point to create the geotechnical 

profile. 

The profile will be created, the strata 

will be hatched and any matching log 

strips will be projected onto the profile. 

 

 

18. The alignment grips can now be used to drag-and-drop to reposition the profile, do this a 

number of times to get a feel of the current geology.  
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Comprehend the Use and Role of Feature Lines and Break Lines in Modelling 

Geology 
In this section we are going to look at the role of feature lines and break lines to model geology 

data. From the available tools in AutoCAD Civil 3D the ability to create 3D feature lines 

representing a precise location the geology surfaces should pass through is an excellent tool in 

modelling the data. 

There are however, there are a number of 

considerations. 

 At any one location there are normally up to 4 

surfaces that need to be modified, for instance 

when modelling the extents of geology, in this 

example of the gravel extents, four surfaces will 

pass through the same point/line. 

 

 

 The feature lines need to have an appropriate elevation, often this is done by moving the 

feature line to the elevation given by an existing surface, in this example we will use the 

Sandstone top. Often there is not a suitable site surface to be used, in this case the 

elevation has to be changed by eye. 

 Feature lines can clash, if a 

feature line overlays another 

feature line in plan, they will 

interact with each other and 

will change elevation, see 

image 2. Notice how the 

feature line running from left 

to right is snapped down 

onto the other feature line. 

Placing the feature lines on 

different sites will prevent 

this from happening, see 

image 3. 

 

Exercise 5: Using Feature Lines and Break Lines to Model Geology 

In this exercise we will model the extents of the gravel stratum. 
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The outline steps are: 

 Draw a polyline representing the extents of the gravel. 

 Convert the polyline into a feature line using the Sandstone - top as the elevation 

 Add the feature line as break lines to the four surfaces 

 Sandstone - Top 

 Gravel – Base 

 Gravel – Top 

 Made – Base 

 

1. Open exercise 5.dwg in the folder: 

C:\Datasets\Hands–On–Labs\CV5674-L Modeling and Visualizing Geology Subsurfaces 

with AutoCAD Civil 3D Ready for BIM  

2. From the Home tab, pick   to draw a polyline. 

3. It is important that the polyline is snapped to the correct location, 

ensure the Object Snap Nearest is enabled. 

 

4. Draw the polyline representing the extents of the gravel 

geology, use nearest snap to the boundary of the 

surfaces as indicated beside: 
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5. From the Home tab feature line list pick Create Feature Line 

from Objects and select the polyline just drawn. 

 

 

 

 

6. In the Feature Line dialog box pick Create New Site. 

 

7. In the new dialog enter the site name of Gravel Base and press Okay to return to the 

Feature Line dialog. 

8. Toggle on Erase existing entities. 

9. Toggle on Assign elevation. 

10. Press Okay to continue. 
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11. In the Assign Elevation dialog, ensure From Surface 

is selected and from the drop-down list select 

SANDSTONE – Top. 

12. Press Okay to continue. 

The polyline will be converted into a feature line using 

the elevation from the SANDSTONE – Top surface. 

 

13. Select the newly created feature line. The ribbon should be updated to display the Feature 

Line tab. 

14. From the Feature Line tab select Add to Surface as 

Breakline, in the dialog select surface SANDSTONE – 

Top . 

15. Press Okay to continue. 

16. And press Okay again. 

The Sandstone – top surface will be updated incorporating the feature line as a breakline. 

The surface will now follow the line. 

17. Whilst keeping the feature line selected follow steps 14 to 16 for the following three 

surfaces: 

 Gravel – Base 

 Gravel – Top 

 Made – Base 

The feature line is incorporated as a breakline in all four surfaces, modelling the extents of 

the gravel. 

Because a feature line has been used to model the geology, if the feature line is modified, the 

elevation changed or the geometry updated, all corresponding surfaces will also be updated 

reflecting the change. (Note: for modelling geology it is best to have surface Rebuild 

Automatically enabled). 

18. In the top right viewport modify the alignment position to check if the gravel has been 

modelled correctly. Also orbit the model to confirm changes are correct. 

Exercise 5a (optional) 

In this exercise we are going to repeat the steps above, but this time to model the Clay. 
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The process is the same as before, but the stratum surfaces selected will be different. 

The outline steps are: 

 Draw a polyline representing the extents of the play. 

 Convert the polyline into a feature line using the Gravel - top as the elevation 

 Add the feature line as break lines to the four surfaces 

 Made - Base 

 Clay - Top 

 Clay – Base 

 Gravel – Top 

 

1. Repeat steps 4 to 18 above using the information below.  

2. For Step 4 above, draw a polyline similar to 

the one to the right. 

3. For Step 7 above, specify Clay -Base as 

the site name. 

4. For Step 11 above, use Gravel – Top. 

5. For Steps 14 -17 above repeat for: 

 Gravel – Top 

 Clay – Base 

 Clay – Top 

 Made – Base 

The clay geology should now be modeled. 
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Learn how to convert the subsurface data in AutoCAD software 3D solids 

ready for export 
In this last section we will look at techniques to convert the top and base surfaces created by 

the Geotechnical Module into solids that can be exported and used by other systems. 

The method uses standard AutoCAD 3D commands. 

Outline process: 

1. Extract triangles from top surface. 

2. Extruded all triangles in the same direction. 

3. Union all newly created solids into one single solid. 

4. Repeat the above three steps for the base surface, triangles must be extruded in the same 

direction as above. 

5. Use the subtraction command and subtract the base solid from the top solid. 

6. The result is an Autocad solid representing the stratum. 

For the process to work well the top and base surfaces should have identical boundaries in 

plan, i.e. one surface should not overhang the other. 

Exercise 6: Creating a AutoCAD solid 

The drawing has been cleaned up so only the Gravel top and base surfaces are displayed. 

1. Open exercise 6.dwg in the folder: 

C:\Datasets\Hands–On–Labs\CV5674-L Modeling and Visualizing Geology Subsurfaces 

with AutoCAD Civil 3D Ready for BIM  

2. From the Geotechnical tab click Strata Manager 

 

Note: If the following message is displayed: 

 

Click Okay, then click Check for Updates in the Geotechnical tab, click Okay and 

then try the Strata Manager again. 
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3. In the Stratum Manager toggle off the Gravel 

bottom surface, so only the top surface is 

displayed. 

4. From the model space select the surface, the 

Surface context Tab should be displayed for the 

Gravel – Top surface. 

5. Click Extract Objects from the Surface tab. 

6. In the Extract Objects from Surface dialog ensure triangles is toggled on. 

7. Press Okay to continue. 

Individual 3D triangular faces will be created for the 

surface. 

8. Click Strata Manager and toggle off the Gravel Top 

surface so only the newly created triangles are displayed. 

9. Now change the workspace to the 3D Modeling, by 

selecting 3D Modeling from the workspace list at 

the top of the page. 

10. From the Home tab click Extrude. 

11. Select all of the triangular faces 

12. In the command line type: MO and ensure Solid mode is set 

13. In the command line type: D for the Direction option 

14. In the command line for the Extrude specify start point of direction: type 0,0,0 

15. In the command line for the Extrude specify end point of direction: type 0,0,-100 

The individual triangles will all be extruded in 

the same direction, creating a series of 

individual prisms. 

We now need to use the Union command to 

combine these together. 

16. From the Solid tab click Union. 

17. Select all of the newly created prisms and 

press Enter. 
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The prisms will be combined into one solid. 

18. Right click on the newly created solid to display the 

context menu, from Isolate Objects Pick Hide 

Selected Objects. To temporarily remove the solid 

from display. 

 

 

The above steps now need to be repeated to create a solid for the Gravel - base surface. 

19. From the Strata Manager toggle on the Gravel – Base surface 

20. From the model space select the surface, the Surface context Tab should be displayed for 

the Gravel – Base surface. 

21. Click Extract Objects from the Surface tab. 

22. In the Extract Objects from Surface dialog ensure triangles is toggled on. 

23. Press Okay to continue. 

Individual 3D triangular faces will be created for the 

surface. 

24. Click Strata Manager and toggle off the Gravel Base 

surface so only the newly created triangles are displayed. 

25. From the Home tab click Extrude. 

26. Select all of the triangular faces 

27. In the command line type: D for the Direction option 

28. In the command line for the Extrude specify start point of direction: type 0,0,0 

29. In the command line for the Extrude specify end point of direction: type 0,0,-100 

The individual triangles will all be extruded in the same direction created a series of 

individual prisms. 

We now need to use the Union command to combine these together. 

30. From the Solid tab click Union. 

31. Select all of the newly created prisms and press Enter. 
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The prisms will be combined into one solid. 

32. Right click on the model space to display the context 

menu and from Isolate Objects click End Object 

Isolation. 

Both solids just created will be displayed. 

33. From the Solid Tab click Subtract. 

The base solid is going to be subtracted from the top solid to create a solid representing our 

stratum. 

34. Select the Top solid:  

35. Press Enter. 

36. Select the Base solid. 

37. Press Enter. 

 

 

The resultant solid should represent the stratum, this object can then be exported and used in 

other software. 

 

Exercise 7 (optional) 



Modeling and Visualizing Geology Subsurfaces with AutoCAD Civil 3D Ready for BIM 

29 
 

Repeat the above process for the Clay stratum, before starting, isolate and hide the Gravel 

solid. 


